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General Windows Shortcuts 

1. Ctrl + A: Select all. 

2. Ctrl + C: Copy. 

3. Ctrl + X: Cut. 

4. Ctrl + V: Paste. 

5. Ctrl + Z: Undo. 

6. Ctrl + Y: Redo. 

7. Alt + Tab: Switch between open applications. 

8. Alt + F4: Close the active window. 

9. Ctrl + W: Close the current tab or window. 

10. Windows Key + D: Show desktop. 

File Management 

11. Ctrl + N: Open a new window. 

12. Ctrl + S: Save. 

13. Ctrl + P: Print. 

14. F2: Rename the selected file. 

15. Ctrl + Shift + N: Create a new folder. 

16. Alt + Enter: Open file properties. 

17. Shift + Delete: Permanently delete a file. 

18. Ctrl + Shift + Esc: Open Task Manager. 

19. Ctrl + T: Open a new tab in browsers. 

20. Ctrl + R: Refresh the current window. 

Text Formatting 

21. Ctrl + B: Bold text. 

22. Ctrl + I: Italicize text. 

23. Ctrl + U: Underline text. 

24. Ctrl + E: Center align text. 

25. Ctrl + L: Left align text. 

26. Ctrl + R: Right align text. 

27. Ctrl + K: Insert a hyperlink. 

28. Ctrl + Shift + L: Apply bullet points. 

29. Ctrl + Shift + >: Increase font size. 

30. Ctrl + Shift + <: Decrease font size. 

Browser Shortcuts 

31. Ctrl + Shift + T: Reopen the last closed tab. 

32. Ctrl + D: Bookmark the current page. 

33. Ctrl + Shift + Del: Open Clear Browsing Data menu. 
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34. Ctrl + H: Open browsing history. 

35. Ctrl + J: Open Downloads page. 

36. Ctrl + F: Find on the page. 

37. Ctrl + +: Zoom in. 

38. Ctrl + -: Zoom out. 

39. Ctrl + 0: Reset zoom to default. 

40. F5: Reload the page. 

Command Prompt Shortcuts 

41. Ctrl + C: Copy selected text. 

42. Ctrl + V: Paste text. 

43. Ctrl + M: Enter Mark Mode to select text. 

44. Up/Down Arrow: Navigate command history. 

45. Ctrl + F: Search in Command Prompt. 

46. Ctrl + A: Select all text in the current buffer. 

47. Tab: Auto-complete folder or file names. 

48. Ctrl + Shift + C: Copy the entire console output. 

49. Ctrl + Shift + V: Paste content in the console. 

50. Alt + Enter: Toggle full screen. 

Microsoft Word Shortcuts 

51. Ctrl + N: Create a new document. 

52. Ctrl + O: Open an existing document. 

53. Ctrl + Shift + S: Open Save As dialog. 

54. Ctrl + Shift + C: Copy formatting. 

55. Ctrl + Shift + V: Paste formatting. 

56. Ctrl + Home: Go to the beginning of the document. 

57. Ctrl + End: Go to the end of the document. 

58. Ctrl + Enter: Insert a page break. 

59. Ctrl + Backspace: Delete the previous word. 

60. Ctrl + Delete: Delete the next word. 

Microsoft Word Shortcuts (Continued) 

61. Ctrl + Shift + F: Change font. 

62. Ctrl + Shift + P: Change font size. 

63. Ctrl + 1: Apply single-line spacing. 

64. Ctrl + 2: Apply double-line spacing. 

65. Ctrl + 5: Apply 1.5-line spacing. 

66. Ctrl + Q: Remove paragraph formatting. 

67. Ctrl + Shift + >: Increase font size. 

68. Ctrl + Shift + <: Decrease font size. 

69. Alt + Ctrl + S: Split the window. 

70. Alt + Shift + D: Insert the current date. 



Excel Shortcuts 

71. Ctrl + ;: Insert the current date. 

72. Ctrl + Shift + :: Insert the current time. 

73. Alt + Enter: Start a new line in the same cell. 

74. Ctrl + D: Fill down the data. 

75. Ctrl + R: Fill data to the right. 

76. Ctrl + `: Toggle between showing formulas and values. 

77. Ctrl + Shift + L: Apply/remove filters. 

78. F2: Edit the selected cell. 

79. Shift + Space: Select the entire row. 

80. Ctrl + Space: Select the entire column. 

PowerPoint Shortcuts 

81. Ctrl + M: Insert a new slide. 

82. Ctrl + D: Duplicate the selected slide. 

83. Ctrl + K: Insert a hyperlink. 

84. Ctrl + Shift + G: Ungroup objects. 

85. Ctrl + G: Group objects. 

86. Ctrl + E: Center align text. 

87. F5: Start the slideshow from the beginning. 

88. Shift + F5: Start the slideshow from the current slide. 

89. Ctrl + P: Annotate with the pen tool during the slideshow. 

90. B: Pause the slideshow and display a black screen. 

Windows Operating System Shortcuts 

91. Windows Key + E: Open File Explorer. 

92. Windows Key + L: Lock the computer. 

93. Windows Key + S: Open search bar. 

94. Windows Key + Shift + S: Take a screenshot with Snipping Tool. 

95. Windows Key + I: Open Settings. 

96. Windows Key + X: Open the Quick Access Menu. 

97. Windows Key + Tab: Open Task View. 

98. Windows Key + P: Switch display modes. 

99. Windows Key + Ctrl + D: Create a new virtual desktop. 

100. Windows Key + Ctrl + Left/Right Arrow: Switch between virtual desktops. 

Outlook Shortcuts 

101. Ctrl + Shift + M: Create a new email. 

102. Ctrl + R: Reply to an email. 

103. Ctrl + Shift + R: Reply all. 

104. Ctrl + F: Forward an email. 

105. Ctrl + Shift + K: Create a new task. 



106. Ctrl + 1: Go to Mail. 

107. Ctrl + 2: Go to Calendar. 

108. Ctrl + 3: Go to Contacts. 

109. Ctrl + E: Search in Outlook. 

110. Alt + S: Send an email. 

Advanced Browser Shortcuts 

111. Ctrl + Shift + B: Show/hide the bookmarks bar. 

112. Alt + Home: Go to the browser's home page. 

113. Ctrl + Shift + O: Open the bookmarks manager. 

114. Ctrl + Shift + P: Open a new private browsing window. 

115. F11: Enter/exit full-screen mode. 

116. Ctrl + 1, 2, 3...: Switch to the corresponding tab. 

117. Ctrl + Shift + N: Open a new incognito window. 

118. Ctrl + U: View the page source. 

119. Ctrl + Shift + J: Open Developer Tools. 

120. Ctrl + L: Focus on the address bar. 

System-Wide Shortcuts 

121. Alt + PrtScn: Take a screenshot of the active window. 

122. Ctrl + Shift + Esc: Open Task Manager. 

123. Alt + Spacebar: Open the window menu. 

124. Shift + Click on Taskbar App: Open a new instance of the app. 

125. Ctrl + Alt + Del: Open security options. 

126. Ctrl + Shift + N: Create a new folder. 

127. Windows Key + Up Arrow: Maximize the active window. 

128. Windows Key + Down Arrow: Minimize the active window. 

129. Windows Key + Left Arrow: Snap the window to the left. 

130. Windows Key + Right Arrow: Snap the window to the right. 

Windows System Shortcuts (Continued) 

131. Ctrl + Shift + Left/Right Arrow: Select text by entire words. 

132. Ctrl + Arrow Up/Down: Scroll the document one paragraph at a time. 

133. Alt + Left Arrow: Go back in File Explorer or browser. 

134. Alt + Right Arrow: Go forward in File Explorer or browser. 

135. Windows Key + A: Open the Action Center. 

136. Windows Key + H: Open the Dictation Tool. 

137. Windows Key + U: Open the Accessibility Settings. 

138. Windows Key + + (Plus): Open Magnifier and zoom in. 

139. Windows Key + - (Minus): Zoom out with Magnifier. 

140. Windows Key + G: Open the Xbox Game Bar. 

Text Navigation Shortcuts 



141. Ctrl + Left Arrow: Move the cursor one word to the left. 

142. Ctrl + Right Arrow: Move the cursor one word to the right. 

143. Ctrl + Up Arrow: Move the cursor to the beginning of the paragraph. 

144. Ctrl + Down Arrow: Move the cursor to the end of the paragraph. 

145. Home: Move the cursor to the beginning of the line. 

146. End: Move the cursor to the end of the line. 

147. Ctrl + Home: Move to the beginning of the document. 

148. Ctrl + End: Move to the end of the document. 

149. Ctrl + Shift + Home: Select text from the cursor to the beginning of the     

document. 

150. Ctrl + Shift + End: Select text from the cursor to the end of the document. 

Microsoft Excel Shortcuts (Continued) 

151. Ctrl + Shift + +: Insert a new cell or row. 

152. Ctrl + -: Delete the selected cells. 

153. Ctrl + Shift + 5: Apply the percentage format. 

154. Ctrl + Shift + 4: Apply the currency format. 

155. Ctrl + Shift + 1: Apply the number format. 

156. Alt + H + O + I: Auto-fit column width. 

157. Ctrl + Alt + V: Open the Paste Special dialog. 

158. Shift + F11: Insert a new worksheet. 

159. Alt + =: Auto-sum selected cells. 

160. F4: Repeat the last action. 

Presentation Shortcuts (PowerPoint Continued) 

161. Ctrl + Shift + N: Start a new presentation. 

162. Ctrl + Shift + Up/Down Arrow: Move a slide up or down. 

163. Ctrl + Up/Down Arrow: Navigate through slides. 

164. Ctrl + G: Go to a specific slide. 

165. Ctrl + Shift + >/<: Increase or decrease font size in a text box. 

166. Ctrl + Shift + D: Duplicate the current slide. 

167. Shift + Drag: Constrain object movement to a straight line. 

168. Ctrl + T: Open the font dialog box. 

169. Alt + F5: Rehearse the slideshow. 

170. Alt + Shift + F9: Display gridlines. 

Web Browser Shortcuts (Advanced) 

171. Ctrl + Shift + Q: Quit the browser. 

172. Ctrl + Shift + M: Switch user profiles in the browser. 

173. Alt + D: Highlight the URL in the address bar. 

174. Ctrl + Shift + H: Open browsing history in a new tab. 

175. Ctrl + Shift + E: Open all tabs in the tab manager view. 

176. F6: Switch focus between the browser elements. 



177. Ctrl + Shift + Tab: Switch to the previous tab. 

178. Ctrl + Shift + L: Open the selected link in a new tab. 

179. Ctrl + N: Open a new browser window. 

180. Ctrl + Shift + B: Toggle bookmarks bar visibility. 

Command Prompt Shortcuts (Continued) 

181. Ctrl + A: Select all text in Command Prompt. 

182. Esc: Clear the current command. 

183. Alt + F7: Clear the command history. 

184. F7: Display a list of previously entered commands. 

185. Ctrl + Up/Down Arrow: Scroll the output buffer. 

186. Ctrl + Insert: Copy selected text to clipboard. 

187. Shift + Insert: Paste from clipboard. 

188. Shift + Up/Down Arrow: Select text in Command Prompt. 

189. Ctrl + Break: Stop the execution of a command. 

190. F3: Repeat the last command. 

Windows File Explorer Shortcuts 

191. Alt + D: Highlight the address bar. 

192. Ctrl + Shift + E: Display all folders above the current folder. 

193. Alt + P: Show/Hide the preview pane. 

194. Alt + Enter: Open the file properties. 

195. Shift + F10: Open the context menu for the selected item. 

196. Ctrl + Shift + 2: View items as tiles. 

197. Ctrl + Shift + 3: View items as a detailed list. 

198. Ctrl + Shift + 4: View items as small icons. 

199. Ctrl + Shift + 6: View items as extra-large icons. 

200. Alt + Up Arrow: Go up one folder level. 

Windows File Explorer Shortcuts (Continued) 

201. Ctrl + N: Open a new File Explorer window. 

202. Alt + Left Arrow: Navigate to the previous folder. 

203. Alt + Right Arrow: Navigate to the next folder. 

204. Shift + Delete: Permanently delete the selected file without moving it to the 

Recycle Bin. 

205. F4: Open the address bar drop-down. 

206. Ctrl + Shift + Number (1-8): Change the folder view type (e.g., Details, List, 

Icons). 

207. Ctrl + L: Highlight the address bar. 

208. Ctrl + F: Search for files in the current folder. 

209. Ctrl + Shift + T: Reopen the last closed folder tab (if supported). 

210. Alt + F: Open the File menu. 



Windows Run Dialog Shortcuts 

211. Windows Key + R: Open the Run dialog. 

212. Ctrl + Shift + Enter: Run a command as Administrator. 

213. Alt + Tab: Switch between active programs after running a command. 

214. F4: View and navigate through previously entered commands. 

215. Alt + Spacebar: Open the system menu for the Run window. 

Windows Settings Shortcuts 

216. Windows Key + I: Open the Settings app. 

217. Alt + Left Arrow: Go back to the previous Settings screen. 

218. Alt + Right Arrow: Go forward to the next Settings screen. 

219. Ctrl + F: Search within Settings. 

220. Windows Key + U: Open the Ease of Access settings. 

Desktop Shortcuts 

221. Windows Key + M: Minimize all open windows. 

222. Windows Key + Shift + M: Restore all minimized windows. 

223. Windows Key + D: Show desktop (toggle). 

224. Ctrl + Shift + Esc: Open Task Manager. 

225. Alt + Spacebar: Open the window menu for the active program. 

Microsoft Word Advanced Shortcuts 

226. Ctrl + Alt + V: Paste Special. 

227. Alt + Shift + R: Copy header/footer from the previous section. 

228. Alt + Shift + Arrow Up/Down: Move a paragraph up or down. 

229. Ctrl + Shift + F5: Set or go to a bookmark. 

230. Ctrl + Shift + Spacebar: Insert a non-breaking space. 

Microsoft Excel Advanced Shortcuts 

231. Ctrl + Shift + U: Expand or collapse the formula bar. 

232. Ctrl + ~: Show all formulas in the worksheet. 

233. Ctrl + Shift + L: Apply or remove filters. 

234. Ctrl + Shift + K: Insert a hyperlink. 

235. Ctrl + Alt + Shift + F9: Force recheck of dependent formulas. 

Browser Advanced Shortcuts (Continued) 

236. Ctrl + Shift + D: Bookmark all open tabs. 

237. Alt + Click: Download the link target. 

238. Ctrl + Shift + Y: Open the browser's Reading Mode (if supported). 

239. Ctrl + Shift + Left/Right Arrow: Move a tab to the left or right. 



240. Ctrl + Shift + Click: Open a link in a new tab and switch to it. 

Zoom and Video Call Shortcuts 

241. Alt + A: Mute/unmute audio. 

242. Alt + V: Start/stop video. 

243. Alt + S: Start/stop screen sharing. 

244. Alt + Shift + R: Start/stop recording. 

245. Alt + H: Open chat window. 

PDF Viewer Shortcuts 

246. Ctrl + O: Open a PDF file. 

247. Ctrl + Shift + S: Save as a new file. 

248. Ctrl + L: Enter full-screen mode. 

249. Ctrl + Shift + H: Read the document aloud (if supported). 

250. Ctrl + Shift + +: Rotate the page clockwise. 

Photo Editing Shortcuts (Common Software) 

251. Ctrl + T: Transform an object. 

252. Ctrl + J: Duplicate the current layer. 

253. Ctrl + Shift + I: Invert the selection. 

254. Ctrl + Shift + E: Merge visible layers. 

255. Ctrl + D: Deselect the current selection. 

Gaming and Multimedia Shortcuts 

256. Alt + Enter: Switch between fullscreen and windowed mode. 

257. Ctrl + Shift + M: Mute/unmute system audio. 

258. Ctrl + Shift + P: Play/pause the media. 

259. Ctrl + Shift + F: Fast forward. 

260. Ctrl + Shift + B: Rewind. 

Keyboard Accessibility Shortcuts 

261. Alt + Shift + Num Lock: Turn on Mouse Keys. 

262. Windows Key + Ctrl + C: Toggle color filters. 

263. Ctrl + Alt + Arrow Keys: Rotate the screen. 

264. Windows Key + Enter: Start Narrator. 

265. Windows Key + Plus (+): Start Magnifier. 

266. Tab: Auto-complete a command or directory. 

267. Ctrl + Arrow Keys: Navigate through arguments in the command. 

268. Shift + Insert: Paste content into the command line. 

269. Ctrl + Shift + Up/Down Arrow: Scroll through command output. 



270. Ctrl + Z: Suspend the current process. 

Windows System Shortcuts (Continued) 

271. Ctrl + Shift + Esc: Open Task Manager directly. 

272. Ctrl + Alt + Down Arrow: Flip the screen upside down. 

273. Ctrl + Alt + Up Arrow: Return the screen to normal orientation. 

274. Windows Key + Ctrl + Shift + B: Reset the display driver. 

275. Windows Key + Ctrl + F: Search for PCs on the network. 

276. Alt + Shift + Tab: Switch between apps in reverse order. 

277. Ctrl + W: Close the current window. 

278. Ctrl + Alt + Delete: Open the Security Options screen. 

279. Ctrl + P: Print the current document or page. 

280. Alt + Esc: Cycle through all open windows. 

Microsoft Word Advanced Formatting Shortcuts 

281. Ctrl + Shift + K: Apply small caps formatting. 

282. Ctrl + Alt + 1: Apply Heading 1 style. 

283. Ctrl + Alt + 2: Apply Heading 2 style. 

284. Ctrl + Alt + 3: Apply Heading 3 style. 

285. Ctrl + Shift + N: Apply the Normal style. 

286. Alt + Ctrl + F: Insert a footnote. 

287. Alt + Ctrl + D: Insert an endnote. 

288. Ctrl + Shift + T: Decrease a hanging indent. 

289. Ctrl + Shift + M: Decrease the left indent. 

290. Ctrl + Shift + C: Copy formatting. 

Microsoft Excel Data Management Shortcuts 

291. Ctrl + T: Create a table from the selected range. 

292. Ctrl + Shift + T: Remove filters from the current table. 

293. Ctrl + K: Insert a hyperlink. 

294. Ctrl + Shift + L: Toggle filters for the current range. 

295. Ctrl + Shift + E: Flash Fill (if supported). 

296. Ctrl + 9: Hide the selected rows. 

297. Ctrl + Shift + 9: Unhide the selected rows. 

298. Ctrl + 0: Hide the selected columns. 

299. Ctrl + Shift + 0: Unhide the selected columns. 

300. Alt + Down Arrow: Open the dropdown menu for the selected cell. 

Browser Advanced Shortcuts (Continued) 

301. Ctrl + Shift + B: Show or hide the bookmarks bar. 

302. Ctrl + Shift + Delete: Open the Clear Browsing Data dialog. 

303. Ctrl + Shift + T: Reopen the last closed tab. 



304. Ctrl + Shift + W: Close the current browser window. 

305. F5: Reload the current page. 

306. Ctrl + F5: Reload the page and bypass the cache. 

307. Alt + Shift + S: Open the share menu (if available). 

308. Ctrl + Shift + N: Open a new incognito/private window. 

309. Ctrl + Shift + E: Open the tab manager. 

310. Ctrl + H: Open the browsing history. 

PowerPoint Advanced Shortcuts 

311. Shift + F5: Start the slideshow from the current slide. 

312. Ctrl + Shift + C: Copy formatting of selected text or object. 

313. Ctrl + Shift + V: Apply copied formatting to the selection. 

314. Alt + F9: Toggle the display of guides. 

315. Ctrl + Shift + G: Group selected objects. 

316. Ctrl + Shift + H: Hide selected objects. 

317. Ctrl + Shift + J: Justify text. 

318. Ctrl + Shift + W: Wrap text in the text box. 

319. Ctrl + G: Open the Go To dialog box. 

320. F12: Save As a new file. 

Command Prompt Advanced Shortcuts 

321. F1: Repeat the previous command character by character. 

322. F2: Repeat part of the previous command up to a specified character. 

323. F8: Search command history for a matching command. 

324. Ctrl + C: Abort the current command. 

325. Ctrl + R: Search backward in command history. 

326. Ctrl + S: Pause output to the screen. 

327. Ctrl + Q: Resume output to the screen. 

328. Ctrl + Z: Mark the end of a file (EOF). 

329. Alt + Enter: Switch to full-screen mode (if supported). 

330. Ctrl + End: Erase the line after the cursor. 

Multimedia Application Shortcuts 

331. Ctrl + P: Play/pause the media. 

332. Ctrl + F: Toggle full-screen mode. 

333. Ctrl + Shift + S: Save the current media file. 

334. Ctrl + T: Open a media file. 

335. Ctrl + Shift + M: Mute/unmute the audio. 

336. Alt + Left Arrow: Rewind 10 seconds. 

337. Alt + Right Arrow: Fast forward 10 seconds. 

338. Ctrl + Up Arrow: Increase the volume. 

339. Ctrl + Down Arrow: Decrease the volume. 

340. Ctrl + Q: Exit the media application. 



Windows General Accessibility Shortcuts 

341. Ctrl + Windows Key + Enter: Start/Stop Narrator. 

342. Alt + Shift + PrtScn: Toggle High Contrast mode. 

343. Windows Key + Spacebar: Switch keyboard layouts. 

344. Windows Key + + (Plus): Start the Magnifier and zoom in. 

345. Windows Key + - (Minus): Zoom out in Magnifier. 

346. Ctrl + Windows Key + M: Open Magnifier settings. 

347. Ctrl + Alt + D: Switch Magnifier to docked mode. 

348. Ctrl + Alt + F: Switch Magnifier to full-screen mode. 

349. Ctrl + Alt + I: Invert colors in Magnifier. 

350. Ctrl + Shift + P: Pause Narrator speech. 

Windows Accessibility Shortcuts (Continued) 

351. Ctrl + Shift + Enter: Open apps as administrator from the Start menu. 

352. Windows Key + Ctrl + O: Toggle the On-Screen Keyboard. 

353. Windows Key + Ctrl + N: Open Narrator settings. 

354. Alt + Shift + Num Lock: Enable Mouse Keys to use the numeric keypad as a 

mouse. 

355. Ctrl + Alt + I: Invert colors on the screen (with Magnifier). 

356. Windows Key + V: Open the Clipboard history. 

357. Ctrl + Shift + Esc: Open the Task Manager directly. 

358. Windows Key + Ctrl + Shift + S: Capture a specific area of the screen (Snip & 

Sketch). 

359. Ctrl + Alt + Del: Open the security options menu. 

360. Ctrl + Shift + N: Create a new folder in File Explorer. 

Microsoft Word Review Shortcuts 

361. Ctrl + Alt + M: Insert a comment. 

362. Ctrl + Shift + E: Turn Track Changes on or off. 

363. Alt + Shift + C: Close the Reviewing Pane. 

364. Ctrl + Shift + G: Open the Word Count dialog. 

365. Alt + Ctrl + I: Preview a document before printing. 

366. Alt + Shift + K: View the Table of Contents. 

367. Ctrl + Shift + A: Format text in all caps. 

368. Alt + Shift + S: Open or close the Split window. 

369. Ctrl + Shift + L: Apply bullet points to selected text. 

370. Ctrl + Shift + H: Apply hidden text formatting. 

Microsoft Excel Navigation Shortcuts 

371. Ctrl + Backspace: Scroll to the active cell. 

372. Ctrl + Spacebar: Select the entire column. 

373. Shift + Spacebar: Select the entire row. 



374. Ctrl + Shift + Spacebar: Select the entire worksheet. 

375. Ctrl + G: Open the Go To dialog box. 

376. Ctrl + Shift + O: Select all cells with comments. 

377. Ctrl + Shift + U: Expand or collapse the formula bar. 

378. Alt + Page Up: Move one screen to the left in a worksheet. 

379. Alt + Page Down: Move one screen to the right in a worksheet. 

380. Ctrl + End: Move to the last cell with data. 

Browser Shortcuts for Developers 

381. F12: Open Developer Tools. 

382. Ctrl + Shift + I: Open the Inspect Element tool. 

383. Ctrl + Shift + J: Open the JavaScript Console. 

384. Ctrl + U: View the page source. 

385. Ctrl + Shift + C: Inspect an element on the page. 

386. Ctrl + Shift + K: Open the Network panel in Developer Tools. 

387. Ctrl + Shift + M: Toggle device toolbar (simulate responsive view). 

388. Ctrl + Shift + P: Open the command menu in Developer Tools. 

389. Ctrl + F5: Perform a hard reload of the page. 

390. Ctrl + Shift + E: Open the performance profiler. 

PowerPoint Presentation Shortcuts 

391. Ctrl + P: Annotate with a pen during a slideshow. 

392. Ctrl + E: Erase annotations during a slideshow. 

393. Ctrl + A: Show the pointer during a slideshow. 

394. W: Pause the slideshow and display a white screen. 

395. B: Pause the slideshow and display a black screen. 

396. Shift + F10: Open the context menu for the selected object. 

397. Alt + R: Switch to the Review tab. 

398. Ctrl + Shift + J: Justify the alignment of text. 

399. Alt + S: Start the slideshow. 

400. Ctrl + M: Insert a new slide. 

Command Prompt File Management Shortcuts 

401. Copy [source] [destination]: Copy files. 

402. Move [source] [destination]: Move files. 

403. Del [filename]: Delete a file. 

404. Md [foldername]: Create a new directory. 

405. Rd [foldername]: Remove a directory. 

406. Dir: List all files and folders in the current directory. 

407. Cls: Clear the screen. 

408. Ren [oldname] [newname]: Rename a file. 

409. Tree: Display directory structure as a tree. 

410. Attrib: View or modify file attributes. 



Windows Taskbar Shortcuts 

411. Windows Key + T: Cycle through taskbar apps. 

412. Shift + Click on an app: Open a new instance of the app. 

413. Ctrl + Shift + Click on an app: Open a new instance of the app as administrator. 

414. Windows Key + Number (1-9): Open the app pinned to the taskbar at the 

specified position. 

415. Shift + Right-click on an app: Open the context menu for the app. 

416. Ctrl + Click on a group of taskbar items: Cycle through the items in the group. 

417. Windows Key + Alt + Number (1-9): Open the Jump List for the app pinned to 

the taskbar. 

418. Windows Key + D: Show or hide the desktop. 

419. Ctrl + Shift + Esc: Open the Task Manager. 

420. Alt + Spacebar: Open the window menu for the active app. 

Advanced Windows Shortcuts 

421. Windows Key + Ctrl + D: Create a new virtual desktop. 

422. Windows Key + Ctrl + Left Arrow: Switch to the virtual desktop on the left. 

423. Windows Key + Ctrl + Right Arrow: Switch to the virtual desktop on the right. 

424. Windows Key + Ctrl + F4: Close the current virtual desktop. 

425. Ctrl + Alt + Tab: View all open windows and navigate through them using arrow 

keys. 

426. Windows Key + Shift + S: Take a screenshot of a selected area. 

427. Windows Key + Shift + M: Restore minimized windows. 

428. Windows Key + Pause/Break: Open System Properties. 

429. Windows Key + L: Lock your computer. 

430. Alt + Enter: Open the Properties window for the selected file or folder. 

Microsoft Word Navigation Shortcuts 

431. Ctrl + Arrow Keys: Move the cursor word by word. 

432. Ctrl + Shift + Arrow Keys: Select text word by word. 

433. Ctrl + Home: Move the cursor to the beginning of the document. 

434. Ctrl + End: Move the cursor to the end of the document. 

435. Shift + F3: Toggle the case of selected text (uppercase, lowercase, title case). 

436. Ctrl + Shift + F6: Switch between open Word documents. 

437. Ctrl + Alt + F1: Open the Help Pane. 

438. Ctrl + Alt + P: Switch to Print Layout view. 

439. Ctrl + Alt + O: Switch to Outline view. 

440. Ctrl + Alt + N: Switch to Draft view. 

Microsoft Excel Editing Shortcuts 

441. Ctrl + ;: Insert the current date. 

442. Ctrl + Shift + :: Insert the current time. 



443. Ctrl + ` (Grave Accent): Toggle the display of formulas. 

444. Ctrl + Shift + U: Expand or collapse the formula bar. 

445. Ctrl + Shift + P: Open the Format Cells dialog box. 

446. Ctrl + Shift + L: Apply or remove filters. 

447. Alt + H + D + R: Delete rows. 

448. Alt + H + D + C: Delete columns. 

449. Ctrl + Alt + V: Open the Paste Special dialog box. 

450. Ctrl + Shift + + (Plus): Insert a new row or column. 

Browser Tab Management Shortcuts 

451. Ctrl + Shift + Tab: Switch to the previous tab. 

452. Ctrl + W: Close the current tab. 

453. Ctrl + T: Open a new tab. 

454. Ctrl + 1 through Ctrl + 9: Switch to a specific tab (numbered from left to right). 

455. Ctrl + N: Open a new browser window. 

456. Ctrl + Shift + W: Close the current browser window. 

457. Ctrl + Shift + P: Open a new private/incognito browsing window. 

458. Ctrl + L: Highlight the address bar. 

459. Ctrl + D: Bookmark the current page. 

460. Ctrl + H: Open browsing history. 

Windows Explorer File Management Shortcuts 

461. Ctrl + Shift + N: Create a new folder. 

462. Ctrl + E: Activate the search bar. 

463. Alt + Enter: Open the Properties dialog for the selected item. 

464. Shift + F10: Open the context menu for the selected item. 

465. Ctrl + N: Open a new File Explorer window. 

466. Ctrl + Shift + E: Expand the navigation pane. 

467. Alt + D: Highlight the address bar. 

468. Alt + P: Toggle the preview pane. 

469. Ctrl + Mouse Scroll Wheel: Adjust the icon size in the current window. 

470. Shift + Delete: Permanently delete the selected file or folder. 

PowerPoint Animation and Transition Shortcuts 

471. Alt + Shift + Left Arrow: Promote a paragraph. 

472. Alt + Shift + Right Arrow: Demote a paragraph. 

473. Ctrl + Shift + G: Group selected objects. 

474. Ctrl + Shift + H: Hide selected objects. 

475. Ctrl + Shift + J: Justify the alignment of text. 

476. Alt + Shift + Up Arrow: Move the selected object up. 

477. Alt + Shift + Down Arrow: Move the selected object down. 

478. Alt + G + H: Open the Animation Pane. 

479. Alt + K: Open the Transitions tab. 



480. Alt + F5: Start the slideshow in Presenter View. 

Command Prompt Advanced Commands 

481. Color [XX]: Change the text and background color. 

482. Title [name]: Set a custom title for the Command Prompt window. 

483. Exit: Close the Command Prompt. 

484. Help: Display a list of available commands. 

485. Set: Display or set environment variables. 

486. Path: Display or modify the search path for executable files. 

487. Fc [file1] [file2]: Compare two files. 

488. Ping [IP/URL]: Test network connectivity. 

489. Ipconfig: Display network configuration. 

490. Netstat: Display active network connections. 

General Keyboard Navigation Shortcuts 

491. Ctrl + Tab: Navigate through tabs in applications. 

492. Shift + Ctrl + Tab: Navigate backward through tabs. 

493. Ctrl + P: Open the print dialog. 

494. Ctrl + S: Save the current file or document. 

495. Alt + F4: Close the active window or program. 

496. Ctrl + O: Open a file. 

497. Ctrl + F: Open the Find dialog to search. 

498. Ctrl + A: Select all items or text in the current view. 

499. Alt + Tab: Switch between open applications. 

500. Ctrl + Q: Quit the current program. 
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